
HUSTLCRAFT
TRADING TECHNOLOGIES

Complete Setup & Troubleshooting Guide

MT5 Expert Advisors | Signal Copier | License Activation

Version 1.0 | March 2026

hustlcraft.com.ng



HustlCraft Trading Technologies Setup & Troubleshooting Guide v1.1

hustlcraft.com.ng Page 1 support@hustlcraft.com.ng

Table of Contents
1. Before You Start — Requirements

2. How to Install Any EA on MT5 (Step-by-Step)

3. How to Activate Your HustlCraft License

4. Product Setup: HC Signal Copier

5. Product Setup: Auto SL/TP Enforcer

6. Product Setup: Daily Loss Limiter

7. Product Setup: Loss Streak Breaker

8. Product Setup: Max DD Guardian

9. Product Setup: HC Ultimate Bundle

10. Product Setup: HC Prop Firm Guardian

11. Product Setup: HC Basket Analyst

12. General MT5 Troubleshooting

13. HustlCraft License Troubleshooting

14. Signal Copier Troubleshooting

15. Protection EA Troubleshooting

16. Quick Reference Card



HustlCraft Trading Technologies Setup & Troubleshooting Guide v1.0

Page 3hustlcraft.com.ng support@hustlcraft.com.ng

1. Before You Start - Requirements

What You Need

Requirement Details

Platform MetaTrader 5 (MT5) - desktop version for Windows

Account Type Hedging account (not Netting). Check with your broker.

Internet Stable connection required for license activation and signal copying

License Key Received via email after purchase. Format: HC-XXXX-XXXX-XXXX-XXXX

WebRequest URL https://api.hustlcraft.com.ng (must be whitelisted in MT5)

Broker Any MT5 broker. Recommended: ICMarkets, HFM. See affiliate links below.

WARNING: HustlCraft EAs are designed for MT5 on Windows. macOS and mobile MT5 do not
support custom Expert Advisors. If you trade on mobile, consider a Windows VPS:
my.hyonix.com/aff.php?aff=5301

TIP: We recommend ICMarkets or HFM for the best compatibility with HustlCraft tools.
Sign up using our partner links for setup bonuses:

Partner Link Why

ICMarkets icmarkets.com/?camp=90458 Low spreads, fast execution, hedging accounts

HFM hfm.com/sv/en/?refid=30513825 Regulated, multiple account types, MT5 support

Hyonix VPS my.hyonix.com/aff.php?aff=5301 Affordable VPS for 24/7 EA operation

Full tracked links: https://icmarkets.com/?camp=90458 | https://www.hfm.com/sv/en/?refid=30513825 |

https://my.hyonix.com/aff.php?aff=5301
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2. How to Install Any EA on MT5
This section applies to ALL HustlCraft EAs. Follow these steps once for each EA you purchased.

Step 1: Download your EA file

After purchase, you receive an email with your .ex5 file and your license key. Download the

.ex5 file to a location you can find easily (e.g., your Downloads folder). The file name will look

like: HC_SignalCopier.ex5 or HC_AutoSLTP_Enforcer.ex5

Step 2: Open your MT5 Data Folder

In MT5, click File in the top menu bar, then click Open Data Folder. A Windows Explorer

window opens showing your MT5 data directory. This is NOT the same as the MT5 installation

folder - it is where MT5 stores your personal files.

Typical path: C:\Users\YourName\AppData\Roaming\MetaQuotes\Terminal\[ID]\

Step 3: Copy the .ex5 file to the Experts folder

In the Data Folder window, navigate to: MQL5 > Experts. Copy (or drag) your downloaded

.ex5 file into this Experts folder. Do NOT put it in Indicators, Scripts, or any other folder.

NOTE: Folder structure: Data Folder > MQL5 > Experts > [your .ex5 file goes here]

Step 4: Refresh the Navigator panel in MT5

Go back to MT5. Press Ctrl+N to open the Navigator panel (left side). Right-click on Expert
Advisors and select Refresh. Your EA should now appear in the list. If it does not, restart

MT5 completely.

Step 5: Enable AutoTrading and WebRequest

Before attaching the EA, you MUST configure two settings:

A) Enable AutoTrading: Click the AutoTrading button in the MT5 toolbar. It must show

green (enabled). If it is red, click it to toggle.

B) Allow WebRequest: Go to Tools > Options > Expert Advisors tab. Check the box:

Allow WebRequest for listed URL. Click Add and enter: https://api.hustlcraft.com.ng

Click OK to save.

WARNING: If you skip the WebRequest step, the EA will NOT be able to validate your
license. You will see 'License validation failed' in the Experts tab.

Step 6: Attach the EA to a chart

Open a chart for any symbol (e.g., EURUSD). In the Navigator panel, find your EA under

Expert Advisors. Double-click it or drag it onto the chart. A properties window opens.

Step 7: Configure EA properties
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In the properties window:

- Common tab: Check Allow Algo Trading. Check Allow modification of Signals settings
if shown.

- Inputs tab: Enter your License Key in the LicenseKey field. Configure other inputs as

described in the product-specific section below.

Click OK.

Step 8: Verify the EA is running

Check the top-right corner of your chart. You should see the EA name with a small icon. In

MT5, a blue hat icon means the EA is loaded and active. If you see a gray icon or no icon,

something is wrong - check the Experts tab (Ctrl+T, Experts tab) for error messages.

TIP: Always check the Experts tab at the bottom of MT5 for messages from your EA. This
is your first stop for diagnosing any issue.
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3. How to Activate Your HustlCraft License
Every HustlCraft EA requires a valid license key. Here is how the activation works:

Step 1: Enter your license key

When you attach the EA to a chart, the Inputs tab will show a field called LicenseKey. Paste

your license key exactly as received in your email. Format: HC-XXXX-XXXX-XXXX-XXXX. Do

not add spaces before or after the key.

Step 2: The EA contacts the HustlCraft server

On first load, the EA sends a validation request to api.hustlcraft.com.ng. This is why you

must enable WebRequest (Section 2, Step 5). The server checks: Is this key valid? Is it for the

correct product? How many terminals are using it?

Step 3: Terminal registration

Each license allows activation on up to 3 terminals (e.g., your laptop, VPS, and a backup).

The first time you activate on a new machine, it registers that terminal. If you hit the 3-terminal

limit, you can reset your terminals from the thank-you page or contact support.

Step 4: Offline grace period

If your internet drops temporarily, the EA continues working for up to 7 days using cached

validation. After 7 days offline, the EA will stop functioning until it can reconnect to the server.

License Rules

Rule Details

Max terminals per key 3 (can be reset via thank-you page or support)

Product binding Each key works only for the product it was purchased for

Bundle keys (ALL) HC Ultimate Bundle keys work for all HustlCraft EAs

Offline grace 7 days - EA continues working without internet for up to 7 days

Re-validation EA re-checks with server every 24 hours when online

Revoked keys If revoked (e.g., refund), the EA stops on next validation check
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4. Product Setup: HC Signal Copier
Product slug: HC-SignalCopier

Copies HustlCraft trades from the Darwinex signal source directly to your MT5 account. Proportional lot
sizing adjusts trade sizes to match your account balance.

Chart & Timeframe

Chart: Any symbol (e.g., EURUSD). The Copier monitors all pairs automatically.

Timeframe: Any timeframe. The Copier does not use chart data.

Input Parameters

Parameter Description Default

LicenseKey Your HC license key HC-XXXX-XXXX-XXXX-XXXX

RiskPercent Position size as % of balance 1.0 (default)

MaxSlippage Maximum allowed slippage in points 30

PollIntervalSec How often to check for new signals (seconds) 5

Important Notes

The Copier polls the HustlCraft relay server every 5 seconds for new signals. When a trade is detected,
it opens a proportionally sized position on your account. Modifications (SL/TP changes) and closures
are also copied automatically. Your account must have sufficient free margin. If a trade is rejected by
your broker, check the Experts tab for the specific error.

Tips

TIP: Run on a VPS for 24/7 operation - if your PC is off, you miss signals. Get a VPS
at my.hyonix.com/aff.php?aff=5301

TIP: Start with RiskPercent = 0.5 on a demo account to test before going live.

TIP: Ensure your broker offers the same symbols as the signal source (e.g., EURUSD,
GBPUSD, XAUUSD). We recommend ICMarkets (icmarkets.com/?camp=90458) or HFM
(hfm.com/sv/en/?refid=30513825).

TIP: Some brokers add suffixes (e.g., EURUSD.pro). The Copier handles this
automatically.
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5. Product Setup: Auto SL/TP Enforcer
Product slug: HC-AutoSLTP-Enforcer

Automatically applies stop-loss and take-profit to every new trade on the account. Prevents the common
mistake of forgetting to set protective levels.

Chart & Timeframe

Chart: Any symbol. The EA monitors all trades on the account.

Timeframe: Any timeframe.

Input Parameters

Parameter Description Default

LicenseKey Your HC license key HC-XXXX-XXXX-XXXX-XXXX

DefaultSL_Points Default stop-loss in points 500 (= 50 pips for 5-digit brokers)

DefaultTP_Points Default take-profit in points 1000

ApplyToExisting Apply to trades already open true

Important Notes

This EA scans for trades without SL/TP set and adds them within seconds. It works across all symbols
on the account. If you manually set SL/TP before the EA acts, it will not override your manual levels.
Points = pips x 10 for 5-digit brokers.

Tips

TIP: For prop firm accounts, set SL/TP values that comply with your firm's rules.

TIP: If you use other EAs that set their own SL/TP, this EA will skip trades that
already have levels set.
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6. Product Setup: Daily Loss Limiter
Product slug: HC-DailyLossLimiter

Caps the maximum loss allowed per trading day. If the daily loss limit is hit, the EA closes all open
trades and prevents new ones until the next trading day.

Chart & Timeframe

Chart: Any symbol. Monitors account-wide.

Timeframe: Any timeframe.

Input Parameters

Parameter Description Default

LicenseKey Your HC license key HC-XXXX-XXXX-XXXX-XXXX

MaxDailyLossPercent Maximum daily loss as % of starting balance 3.0

CloseAllOnLimit Close all trades when limit hit true

AlertOnly Only alert, do not close trades false

Important Notes

Daily loss is calculated from midnight server time. The starting balance is recorded at day start. If
(current equity - day start balance) exceeds the negative threshold, action is triggered. On prop firm
accounts, set this below your firm's daily limit (e.g., if firm allows 5%, set EA to 3-4%).

Tips

TIP: For FTMO: Set to 4% (FTMO limit is 5%, gives you a 1% safety buffer).

TIP: AlertOnly mode is useful for monitoring without automatic intervention.
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7. Product Setup: Loss Streak Breaker
Product slug: HC-LossStreakBreaker

Halts trading after a defined number of consecutive losing trades. Prevents emotional revenge trading
and tilt-driven account damage.

Chart & Timeframe

Chart: Any symbol. Monitors account-wide.

Timeframe: Any timeframe.

Input Parameters

Parameter Description Default

LicenseKey Your HC license key HC-XXXX-XXXX-XXXX-XXXX

MaxConsecutiveLosses Number of consecutive losses before halt 3

CooldownHours Hours to wait before allowing new trades 4

CloseOpenTrades Close any open trades on trigger false

Important Notes

The EA tracks the last N closed trades. If they are all losses (consecutive), it blocks new trade execution
for the cooldown period. This is a discipline enforcement tool - it prevents the pattern of losing 3 trades
and then taking a revenge trade that loses more.

Tips

TIP: Set MaxConsecutiveLosses based on your strategy's normal loss streak. If your
strategy rarely loses 4 in a row, set it to 4.

TIP: CooldownHours gives you time to step away and reset mentally.
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8. Product Setup: Max DD Guardian
Product slug: HC-MaxDDGuardian

Enforces a maximum equity drawdown limit. If the account equity drops below the defined threshold
from the peak, the EA closes all trades and halts further activity.

Chart & Timeframe

Chart: Any symbol. Monitors account-wide.

Timeframe: Any timeframe.

Input Parameters

Parameter Description Default

LicenseKey Your HC license key HC-XXXX-XXXX-XXXX-XXXX

MaxDrawdownPercent Maximum drawdown from peak equity 8.0

CloseAllOnBreach Close all trades on breach true

AlertViaTelegram Send Telegram alert on breach false

Important Notes

The EA tracks the highest equity reached (high-water mark). Drawdown = (peak equity - current equity)
/ peak equity. This is the last line of defense for your account. For prop firms with 10% max DD rules,
set this to 8% to give yourself a buffer.

Tips

TIP: This EA is critical for prop firm traders. Set it BELOW your firm's maximum.

TIP: If using with other protection EAs, the DD Guardian is the final backstop - Daily
Loss Limiter catches daily issues, DD Guardian catches cumulative damage.
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9. Product Setup: HC Ultimate Bundle
Product slug: ALL

Includes ALL HustlCraft EAs: Signal Copier + Auto SL/TP Enforcer + Daily Loss Limiter + Loss Streak
Breaker + Max DD Guardian. One license key works for every product.

Important Notes

Your Bundle license key (product = ALL) works in any HustlCraft EA. You do NOT need separate keys
for each product. Install each EA following Sections 4-8 above, and use the same license key for all of
them. The 3-terminal limit applies PER PRODUCT, not total - so you can run the Copier on 3 terminals
AND the DD Guardian on 3 terminals simultaneously.

Tips

TIP: Recommended stack for prop firm accounts: Daily Loss Limiter + Loss Streak
Breaker + Max DD Guardian.

TIP: Recommended stack for signal following: Signal Copier + Auto SL/TP Enforcer + Max
DD Guardian.

TIP: Start with demo accounts. Get comfortable with each EA individually before
stacking them.
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10. General MT5 Troubleshooting
These issues are not specific to HustlCraft - they affect any EA running on MT5. We include them here
so you have one reference document for everything.

EA Not Appearing in Navigator

Symptom: You copied the .ex5 file but the EA does not show in the Navigator panel.

Cause: The file is in the wrong folder, or MT5 has not refreshed.

Fix: 1) Confirm the file is in Data Folder > MQL5 > Experts (not Indicators or Scripts). 2)

Right-click Expert Advisors in Navigator and click Refresh. 3) If still missing, close MT5

completely and reopen it.

EA Shows Gray Icon / Not Trading

Symptom: The EA is attached to the chart but has a gray icon and is not placing trades.

Cause: AutoTrading is disabled globally or for this specific EA.

Fix: 1) Click the AutoTrading button in the MT5 toolbar - it must be green. 2) Right-click the

chart > Expert Advisors > Properties > Common tab > check Allow Algo Trading. 3) Check

Tools > Options > Expert Advisors > ensure Allow Auto Trading is checked.

'Trade Is Not Allowed' Error

Symptom: The Experts tab shows 'Trade is not allowed' or error 4109.

Cause: Auto Trading permissions are disabled at one or more levels.

Fix: There are three levels of trading permission in MT5: 1) Global: AutoTrading toolbar

button (must be green). 2) EA-specific: Right-click chart > Expert Advisors > Properties >

Allow Algo Trading. 3) Broker-level: Some brokers or account types disable algo trading.

Contact your broker. All three must be enabled for trades to execute.

WebRequest Error 4060

Symptom: Experts tab shows 'WebRequest to URL failed, error 4060' or similar.

Cause: The EA is trying to contact a URL that is not whitelisted in MT5 settings.

Fix: Go to Tools > Options > Expert Advisors. Check Allow WebRequest for listed URL.

Add: https://api.hustlcraft.com.ng. Click OK. Remove the EA from the chart and re-attach it.
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'Not Enough Money' / Margin Error

Symptom: Trade execution fails with 'Not enough money' or 'No money' error.

Cause: Your account does not have sufficient free margin for the requested lot size.

Fix: 1) Reduce your lot size or RiskPercent setting. 2) Close some open positions to free up

margin. 3) Check your broker's margin requirements for the specific symbol. 4) Some brokers

require higher margin during news events or weekends.

'Invalid Stop Loss' / 'Invalid TP' Error

Symptom: Trade opens but SL/TP is rejected, or modification fails.

Cause: Your SL/TP is too close to the current price (inside the broker's stop level).

Fix: 1) Check your broker's minimum stop level: Market Watch > right-click symbol >
Specification > Stop Level. 2) Increase your SL/TP distance to be at least equal to the stop

level. 3) During high volatility, brokers may widen stop levels temporarily.

EA Disappears After MT5 Update

Symptom: After an MT5 update, your EA is gone from the chart and Navigator.

Cause: MT5 updates can sometimes reset the data folder or require EA re-attachment.

Fix: 1) Check if the .ex5 file is still in the Experts folder. If not, re-copy it. 2) Refresh Navigator

(right-click > Refresh). 3) Re-attach the EA to your chart and re-enter your settings. Your

license remains valid - you just need to re-attach the EA.

Hedging vs Netting Account

Symptom: The EA opens a trade but it modifies an existing position instead of opening a new one.

Cause: You are on a Netting account. HustlCraft EAs require a Hedging account.

Fix: On Netting accounts, opening a second position on the same symbol modifies the existing

one. Check your account type: Navigator > Accounts > right-click your account >
Properties. If it says 'Netting', contact your broker to open a Hedging account, or open a new

demo account with Hedging mode.

Broker Symbol Suffixes

Symptom: The EA cannot find the symbol or trades are not being copied for certain pairs.

Cause: Your broker uses symbol suffixes (e.g., EURUSD.pro, EURUSDm, EURUSD.ecn).
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Fix: The HC Signal Copier handles suffix mapping automatically. For protection EAs, this is

not an issue as they monitor by account, not by symbol. If you encounter symbol issues, check

Market Watch for the exact symbol name your broker uses.
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11. HustlCraft License Troubleshooting
Symptom: 'License validation failed' on EA startup.

Cause: WebRequest not configured, or internet connection issue, or incorrect key.

Fix: 1) Confirm WebRequest is enabled with URL https://api.hustlcraft.com.ng (Section 2,

Step 5). 2) Check your internet connection. 3) Verify you entered the key exactly as received -

no extra spaces, correct capitalization. 4) Check the Experts tab for the specific error message

from the server.

Symptom: 'Terminal limit reached' - cannot activate on this machine.

Cause: You have already activated the license on 3 different terminals.

Fix: Each key allows 3 terminals. If you have decommissioned an old machine: 1) Go to the

HustlCraft thank-you page and use the Reset Terminals function. 2) Or email

support@hustlcraft.com.ng with your license key and we will reset it.

Symptom: 'Wrong product' - license rejected.

Cause: You are using a key purchased for a different EA (e.g., using a Copier key in the DD

Guardian).

Fix: Each key is bound to the product it was purchased for. Check your purchase email for the

correct key. If you purchased the HC Ultimate Bundle, your key works for ALL products.

Symptom: 'License revoked' message.

Cause: The license has been deactivated (e.g., after a refund or by admin action).

Fix: Contact support@hustlcraft.com.ng with your email and order details.

Symptom: EA stops working after 7 days without internet.

Cause: The offline grace period has expired.

Fix: Reconnect your machine to the internet and restart the EA. It will re-validate with the

server and resume normal operation. For VPS users: check that your VPS has not lost its

internet connection. Need a reliable VPS? Visit my.hyonix.com/aff.php?aff=5301
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12. Signal Copier Troubleshooting
Symptom: Copier is running but no trades are being placed.

Cause: No active signals, or the relay server is not returning data, or margin issues.

Fix: 1) Check the Experts tab - the Copier logs every poll cycle. Look for 'No new signals'

(normal if no trades are active) or error messages. 2) Verify the HustlCraft Telegram channel

has recent signals - if no trades are running on Darwinex, there is nothing to copy. 3) Check

your account has sufficient free margin. 4) Confirm your internet connection is stable.

Symptom: Trade was copied but with a different lot size than expected.

Cause: Proportional lot sizing adjusts based on your account balance vs the source account.

Fix: This is normal behavior. The Copier uses your RiskPercent setting to calculate a

proportional size. If you want larger lots, increase RiskPercent. If smaller, decrease it. The

formula: Your lot = Source lot x (Your balance / Source balance) x RiskPercent.

Symptom: Trade modification (SL/TP update) was missed.

Cause: The modification signal arrived during a brief polling gap or network interruption.

Fix: The Copier includes a reconciliation process that checks and syncs open trade

parameters periodically. If you notice a persistent mismatch, remove and re-attach the EA to

trigger a full resync. Check the Experts tab for any 'Modify failed' errors.

Symptom: Trade was opened but not closed when the signal closed.

Cause: Close signal missed, or the Copier was not running when the close occurred.

Fix: 1) If the Copier was offline (PC off, VPS down), it cannot receive close signals. This is

why a VPS is strongly recommended (my.hyonix.com/aff.php?aff=5301). 2) You can manually

close the trade in MT5. 3) The Max DD Guardian or Daily Loss Limiter can serve as backstops

for unmanaged trades.

Symptom: Copier says 'OrderSend failed' with an error code.

Cause: The broker rejected the trade for a specific reason.

Fix: Common error codes: 10004 (Requote - price moved, will retry). 10006 (Request rejected

- check broker conditions). 10010 (Invalid price - symbol may not be available). 10014 (Invalid

volume - lot size too small or too large for this symbol). 10019 (Not enough money). Check the

Experts tab for the exact code and message.
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13. Protection EA Troubleshooting
These apply to Auto SL/TP Enforcer, Daily Loss Limiter, Loss Streak Breaker, and Max DD Guardian.

Symptom: Protection EA is running but did not trigger when it should have.

Cause: The threshold was not actually reached, or the EA's calculation method differs from

your expectation.

Fix: 1) Check the Experts tab for the EA's current readings (e.g., current DD %, daily loss %).

2) Verify your input parameters are set correctly. 3) Drawdown is calculated from peak equity,

not from starting balance (for DD Guardian). 4) Daily loss is calculated from midnight server
time, not your local time.

Symptom: EA closed all trades unexpectedly.

Cause: A protection threshold was breached.

Fix: Check the Experts tab for the exact trigger message. Common causes: 1) Sudden market

move (news event) pushed equity past your DD limit. 2) Daily loss limit hit during Asian

session while you were asleep. 3) Multiple losing trades closed in sequence, triggering Loss

Streak Breaker. This is the EA working as designed - it protected your account.

Symptom: Multiple protection EAs conflict with each other.

Cause: Two or more EAs trying to close the same trades simultaneously.

Fix: This is safe - MT5 handles concurrent close requests gracefully. The first EA to close the

trade succeeds; the second will see 'trade already closed' and skip. No double-closing or

errors will occur. The EAs are designed to be used together.
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14. Quick Reference Card

Recommended Partners

Use these partner links to get started with trusted brokers and VPS services. These are trackable
affiliate links - HustlCraft earns a commission at no extra cost to you.

Partner What Link

ICMarkets MT5 Broker - low spreads, fast execution https://icmarkets.com/?camp=90458

HFM MT5 Broker - regulated, multiple account typeshttps://www.hfm.com/sv/en/?refid=30513825

Hyonix Windows VPS - 24/7 EA operation https://my.hyonix.com/aff.php?aff=5301

Key URLs

Purpose URL

License validation (WebRequest) https://api.hustlcraft.com.ng

Website https://hustlcraft.com.ng

FAQ https://hustlcraft.com.ng/faq.html

Support email support@hustlcraft.com.ng

File Locations in MT5

File Type Location (inside Data Folder)

Expert Advisors (.ex5) MQL5 > Experts

Indicators (.ex5) MQL5 > Indicators

Libraries (.dll) MQL5 > Libraries

Log files MQL5 > Files

Preset files (.set) MQL5 > Presets

MT5 Keyboard Shortcuts

Shortcut Action

Ctrl+N Open/close Navigator panel

Ctrl+T Open/close Terminal panel (includes Experts tab)

Ctrl+O Open Options dialog

F7 Open EA properties (when EA is attached)

F8 Open chart properties



HustlCraft Trading Technologies Setup & Troubleshooting Guide v1.0

Page 20hustlcraft.com.ng support@hustlcraft.com.ng

Checklist: First-Time Setup

[ ] 1. Download .ex5 file from purchase email

[ ] 2. Open MT5 > File > Open Data Folder > MQL5 > Experts

[ ] 3. Copy .ex5 file into Experts folder

[ ] 4. Refresh Navigator (right-click > Refresh) or restart MT5

[ ] 5. Enable AutoTrading (green button in toolbar)

[ ] 6. Tools > Options > Expert Advisors > Allow WebRequest > Add https://api.hustlcraft.com.ng

[ ] 7. Attach EA to chart > Inputs tab > Enter license key

[ ] 8. Common tab > Check Allow Algo Trading

[ ] 9. Click OK > Verify EA icon appears on chart

[ ] 10. Check Experts tab for 'License active' confirmation

Need help? Email support@hustlcraft.com.ng - we respond within 24 hours.

HustlCraft Trading Technologies | hustlcraft.com.ng | Version 1.0 | March 2026
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10. Product Setup: HC Prop Firm Guardian
Product slug: HC-PropGuardian

All-in-one challenge survival EA. Bundles five enforcement engines into a single EA with phase-aware presets for major prop

firms. Enforces daily loss limits, max drawdown, loss streak control, trade count and lot limits, and displays a live challenge

progress tracker on the chart.

Chart & Timeframe
Chart: Any symbol (e.g., EURUSD). The EA monitors the entire account.

Timeframe: Any timeframe.

Firm Presets
Select your firm and phase from the FirmPreset input. The EA auto-loads correct limits.

Preset Value Firm Daily Loss Limit Max Drawdown

FTMO_P1 / FTMO_P2 FTMO 5% 10%

THE5ERS_P1 / THE5ERS_P2 The5ers 4% 6%

MYFUNDEDFX MyFundedFX 5% 10%

FUNDEDNEXT FundedNext 5% 10%

DARWINEX Darwinex Zero 5% 10%

CUSTOM Any firm Set manually Set manually

Input Parameters
Parameter Description Default

LicenseKey Your HC license key HC-XXXX-XXXX-XXXX-XXXX

FirmPreset Select firm + phase from preset list FTMO_P1

CustomDailyLossPct Daily loss % limit (CUSTOM preset only) 5.0

CustomMaxDDPct Max drawdown % limit (CUSTOM preset only) 10.0

MaxConsecLosses Consecutive losses before trading halts 3

MaxOpenPositions Maximum simultaneous open positions 5

MaxLotSize Max lot size per trade (0 = unlimited) 0

CloseOnDailyLimit Close all trades when daily loss hit true

CloseOnMaxDD Close all trades when max DD breached true

ShowDashboard Display challenge progress panel on chart true

The Five Enforcement Engines
Engine 1 — Daily Loss Limiter: Monitors intraday P/L. When daily loss hits the preset limit, all trades close and new entries

block until next session.

Engine 2 — Max Drawdown Guardian: Tracks drawdown from peak equity. If ceiling is breached, all trades close immediately

and trading halts.
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Engine 3 — Loss Streak Breaker: Counts consecutive losing closed trades. After the defined count, trading pauses for the

session.

Engine 4 — Trade Count & Lot Limiter: Enforces maximum concurrent open positions and maximum lot size per trade.

Engine 5 — Challenge Progress Tracker: Live on-chart panel: current P/L vs profit target, daily loss remaining, drawdown

remaining, streak count, active preset.

Important Notes
WARNING: Do NOT run Prop Firm Guardian alongside the individual Daily Loss Limiter, Loss Streak Breaker, or Max DD Guardian

EAs on the same account. This EA replaces all four — running both causes duplicate enforcement.

Only ONE instance needed: attach to any single chart — it monitors the full account.

For CUSTOM preset: set limits BELOW your firm's actual thresholds. Always maintain a buffer.

Tips
TIP: Use CUSTOM preset for any firm not in the list — manually enter your limits.

TIP: ShowDashboard = true so you always see your challenge status at a glance.

TIP: Run on a VPS for 24/7 enforcement — if your PC is off, the EA is not protecting you.

TIP: Works on funded accounts too — prop firm rules still apply post-challenge.
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11. Product Setup: HC Basket Analyst
Product slug: HC-BasketAnalyst

Real-time basket position analysis tool. Scans all open positions and displays scenario outcomes, path advantage grading,

pressure zones, and an action bias verdict on a live panel inside MT5. Analysis only — does NOT place, modify, or close any

trades.

Chart & Timeframe
Chart: Any symbol. The EA reads all open positions across all symbols automatically.

Timeframe: Any timeframe. Chart price data is not used for analysis.

Input Parameters
Parameter Description Default

LicenseKey Your HC license key HC-XXXX-XXXX-XXXX-XXXX

PanelPosition Panel corner: 0=top-right, 1=top-left, 2=bottom-right, 3=bottom-left0

PanelFontSize Font size for panel text 10

ShowPressureZones Highlight price levels with clustered SL/TP orders true

ShowPathAdvantage Display directional advantage grading true

ShowActionBias Display the action bias verdict true

RefreshSeconds Panel refresh interval in seconds (minimum: 1) 1

What the Panel Shows
Position Scanner: All open positions: symbol, direction, lot size, entry price, current P/L. Updates every tick.

Scenario Mapper: Total basket P/L if price reaches each SL/TP level across all positions simultaneously.

Path Advantage Grade: Grades which direction gives the basket the better net outcome: Strong Long / Neutral / Strong Short.

Pressure Zones: Price levels where multiple SL/TP orders cluster — zones of maximum P/L exposure.

Action Bias Verdict: Synthesises all analysis into a single directional verdict displayed prominently on the panel.

Important Notes
HC Basket Analyst is a READ-ONLY tool. It does not open, modify, or close positions under any circumstances. Fully compatible

with prop firm accounts that restrict automated trade execution.

WebRequest must still be enabled for license validation (same URL: https://api.hustlcraft.com.ng). No other external calls are

made — all analysis runs locally inside MT5.

Works best with 2+ open positions. Single-position analysis still shows path advantage and pressure zones.

Tips
TIP: Use alongside Prop Firm Guardian — analysis + enforcement is the complete stack.

TIP: Adjust PanelPosition if the panel overlaps your chart or other EA displays.

TIP: Compatible with prop firm accounts — read-only, no trade execution risk.

TIP: RefreshSeconds = 1 gives near-tick updates. Increase to 5 on slower machines.


